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1.0 Introduction

PostalCAD 2015 is the newest release of proprietary USPS CAD software used for documenting
large scale processing plants, stations and branches. The 2015 release integrates directly into
the Autodesk Map 3D 2015 software.

The PostalCAD 2015 Ribbon layout streamlines your work process for easily creating,
documenting and analyzing your facility drawing. The 2015 Ribbon layout groups tools together
at the top of the screen, making them easy to access. Once the new layout of the Ribbon is
learned, workflow time is reduced significantly and users become more productive.

Experienced users have seen changes to the PostalCAD interface in releases over the years.
PostalCAD 2015 ensures that all legacy commands and tools are still active and the keyboard
shortcuts many users have learned are still valid, making the transition as smooth as possible.

Several highlights of this release are a revised Library Manager layout that makes working with
standardized equipment blocks a simple double-click exercise. Dynamic blocks are being used
for many mechanized equipment sets and annotation symbols making the library more versatile.
All new Lean tools have been added for documenting 5S and staging areas. Advanced Affinity
Analysis and Transport Work tools are now simpler to use for optimizing workflows. The standard
file format for drawings using the PostalCAD 2015 release is 2010. Users with 2012 version
software will be able to open files saved in PostalCAD 2015.

Please take the time to thoroughly read through the Features list, which outlines the new
application format for tools and utilities.

PostalCAD 2015 is integral to the installation of AutoCAD Map 3D 2015 64 bit on an USPS ACE

3 computer. Read the Installation Guide Appendix B for further information on obtaining this new
release of PostalCAD 2015.
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2.0 User Interface Overview

(PostalCAD 2015 interface)

2.1 Opening Splash Screen

AutoCAD Map 3D 2015 starts with a splash screen that informs the user the software is
initializing.

(Opening Splash Screen for AutoCAD Map 3D 2015)

Once the software has finished loading, the PostalCAD 2015 workspace is available.
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2.2 User Interface

PostalCAD 2015 has a Ribbon layout developed for use with AutoCAD Map 3D 2015.

o N

1. Open drawing tabs are at the top of the drawing window and can be toggled on or off.
2.
3. Command line is more dynamic. Command line options for commands can now be

Layer Properties Manager has new features.

selected with the mouse. Auto-fill helps find commands quicker.

Template files are available for any type of project. Layout tabs in PostalCAD templates
have standard paper sizes setup to create PDF files.

The PostalCAD Ribbon has been rearranged to include new tools and interface options.
The File, Draw, and Lean tabs have been added. The Home, Layers, and the Print &
Send tabs from the 2012 version have been removed.

Quick Access toolbar is below the Ribbon and contains all the Layer tools.

The External References palette is now showing by default

Status bar icons have moved to the lower right section of the application window and no
longer have the option to show text labels for their functions. These buttons can be
toggled on or off visually.

The overall color scheme has been darkened to create less of an eye strain for users.
Autodesk studies have proven that a darker interface and background color is less likely
to incur fatigue and eye strain over prolonged periods of looking at the screen.

10.Command line defaults to only three rows total. One active command line and only two

lines of history. Press the F2 key will expand the area.

5- New Ribbon
Panel Layout

6- Quick Access
1- Open Files Tabs Layer Toolbar

2- Layer Properties Manager
Palette Enhancements 7- Xref Palette
with Auto-Hide

3- Dynamic Command Line Options

4- Model and Lavyout Templates 8- Status Icons

(The new 2015 PostalCAD workspace)
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2.2.1 Open File Tabs

The open file tabs are used to go between multiple open drawings. Each individual tab can go
to any existing tab within the selected file by hovering over the tab for more than one second
and choosing the appropriate tab from that file. The file tabs have a right-click menu to access
common file tools and to open the New Tab interface.

(Right-click menu of open file tabs)

(Right-click menu of open file tabs)

2.2.2 New Tab

The New Tab screen allows users to choose from several options for opening a template or
existing drawing file.

(New Tab layout)

PostalCAD 2015 Features Guide Neosys Corporation January 2016 page 8



The Get Started area of the New Tab screen has an area for choosing the new PostalCAD 2015
templates for theme specific drawings.

(Get Started area of New Tab)

2.2.3 Ribbon Tabs & Panels

(The new Ribbon layout, quick access tools, and the menu browser button)

The Ribbon is organized by grouping common tools for a given set of tasks into separate tabs.
These tabs replace menu pull-downs. Each tab contains themed panels that organize tasks by

entity type or criteria. The tabs, and corresponding panels within each tab, are reviewed in depth
later in this document.

2.2.4 Quick Access Layer Toolbar

A Quick Access Layer toolbar is always visible and contains all of the layer tools. The expandable
layer control section is now much wider to accommodate longer layer names.

(Quick Access Layer toolbar with layer control box expanded)
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2.2.5 Menu Browser

The large button with a 3D blue cone, in the top left corner of the application window, expands
the limited AutoCAD Map 3D 2015 menu browser items and shows the last 9 files opened in the
recent documents area. The recent files list can be changed to a Quick Preview mode showing
image previews of files rather than a textual list with similar icons. Users can switch between
recent files and open files for the preview area.

(Menu Browser with recently used files shown as large icons and with open files)

2.2.6 Layer Properties Manager Palette

The Layer Properties Manager is in an anchored palette format. The PostalCAD workspace
anchors this palette to the left side of the drawing window for easy access and use. Simply move
the cursor over the anchored palette and the palette expands for use.

(Expanded Layer Properties Manager Palette)
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2.2.7 Properties Palette

The Properties palette is in an anchored format like the Layer Properties Manager palette. The
PostalCAD workspace anchors this palette to the right side of the drawing window along with
the External References palette for easy access and use. Simply move the cursor over the
anchored palette and the palette expands for use.

(Properties Palette)

2.2.8 Quick Properties Palette

The Quick Properties palette is a floating palette that contains only the most common properties
that change. This palette floats near the selection set and is object sensitive. The palette can be
toggled on or off from the status button area in the lower right corner of the application screen.
PostalCAD 2015 shows only the most common properties of entities that need to be modified.

(Floating Quick Properties palette)
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2.2.9 External Reference Palette

The External References palette is in an anchored format like the Layer Properties Manager
palette. The PostalCAD 2015 workspace anchors this palette to the right side of the drawing
window along with the Properties palette for easy access and use. Simply move the cursor over
the anchored palette and the palette expands for use. This palette contains all the creation and
editing tools with the properties of all external references in a drawing.

Note: Externally referenced AutoCAD files are commonly referred to as Xref’'s. Many of these
tools and the PostalCAD toolset for external references can be found in the Xref tab.

(External Reference Palette)

2.2.10 Command Line Autofill with PostalCAD Help

The 2015 command line has an extended auto-fill capability. A full range of selections are
presented that includes all the keyboard shortcuts for both AutoCAD tools and PostalCAD tools.
PostalCAD help panels will appear when users hover over the related keyboard shortcut.

The auto-fill creates a history of the most used commands and will default to those listings first.

(Command line auto-fill with an extended PostalCAD help window)
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2.2.11 Status Bar Buttons

Status Bar buttons are located in the lower right corner of the application window. The buttons
no longer have the ability to toggle between a textual label or an icon. A new Xref status icon
will appear when a file has an external reference file attached. Users can visually suppress this
bar to gain more screen size.

(Status Bar buttons)

2.2.12 Right-Click Shortcut Menus

PostalCAD 2015 has added the Ortho mode toggle to all right-click shortcut menus, where
appropriate. The main context menus have been organized to give users a compact set of tools
for common tasks. A new selection menu contains all of the PostalCAD tools associated with
selection filters and complimentary tools.

The PostalCAD 2015 right-click menu offers a condensed set of tools for the most common
drafting tasks. New for 2015 are the addition of more blocks and the addition of tools for working
with external references. Right clicking after a selection set has been created shows standard
editing commands and the Move 1000’ commands.

(Right-click, no command active, and objects selected)

(Right-click, no command active)
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The shift+ right-click menu has been reorganized to present object snap overrides. The ctl+right-
click menu contains all of the selection filtering tools and the selection filters can now be used
transparently when other commands are active prompted for selecting objects.

(Shift+Right-click menu) (CtlI+Right-click menu)
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3.0 PostalCAD Ribbon Overview

The PostalCAD 2015 Ribbon displays the most frequently used tools, as groups in individual
tabs. The first tab, File, is the beginning of this concept. As the needs become more specific or
if tasks increase in complexity, the user proceeds to the next relevant tab for accomplishing the
task. When lesser used or more complex tools didn't fit in a three row format for a particular
theme, an expandable panel can be shown by clicking on the lower horizontal band of the panel,
if there is a cascade arrow next to the descriptive text. The angled arrow in the lower right corner
of a panel will open a related dialogue box.

NOTE: PostalCAD commands in the Ribbon are preceded with an asterisk (*) in the text label
and all others are AutoCAD commands.

3.1 File Tab

The File tab is a new tab for PostalCAD 2015. The tab contains basic file management tools,
clipboard options and the primary printing utilities. This tab has many of the tools from the
PostalCAD 2012 Home tab. The Microsoft Windows clipboard tools from the PostalCAD 2012
Quick Access Toolbar have moved to this tab. Many of the Print & Send tab tools from the
PostalCAD 2012 version have been rearranged and placed in the Printing panel.

(The new for 2015 File tab)

3.1.1 File Management Panel

The File Management panel contains all of the rudimentary file management tools for opening,
starting, saving and closing. A shortcut to open the Buzzsaw file transfer protocol application is
included. The Options dialogue box can be opened with the arrow in the lower right corner.

(File Management panel)

3.1.2 Clipboard Panel
The Clipboard panel contains all of the needed Windows clipboard tools. The AutoCAD paste to
original coordinate’s option is labeled Paste in Place.

(Clipboard panel)
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3.1.3 Printing Panel
The Printing panel contains the tools used in conjunction with printing and creating a PDF file.
The Plot dialogue box can be opened with the arrow in the lower right corner.

(Printing panel)

3.2 Draw Tab

The Draw tab is a new tab for PostalCAD 2015. The tab combines PostalCAD and AutoCAD
utilities into four separate panels for drawing and editing individual objects.

(Draw tab)

3.2.1 Drawing Panel
The Drawing panel contains tools for drawing objects with curves and circles. The universal
*Pick Draw PostalCAD command is the first button that will edit any type of object.

(Drawing panel)

3.2.2 Linework Panel
The Linework panel is where all the line and polyline tools are placed. This panel includes
polyline editing along with the polyline and rectangle tools.

(Line work panel)
3.2.3 Hatch Panel
The Hatch panel has creation and editing of hatch pattern options. The new for 2015
*Highlighting tool is included.

(Hatch panel)
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3.2.4 Revision Panel

The Revision panel contains a full suite of tools and utilities for documenting revisions. The
*Cloud and *Triangle commands use the *Arc Size listing to set the final sizes of those objects.
The revision tool now adds Mtext notes to be added next to the cloud shaped polyline.

(Revision panel)

3.3 Modify Tab

The Modify tab combines all the PostalCAD and AutoCAD utilities for object modification into
two separate panels. The tab has been rearranged from the PostalCAD 2012 layout. Undo and
Redo have been added to the far left of the tab. A new *Merge Areas and revised alignment tool,
*Align X or Y have been added.

(Modify tab)

3.3.1 Modify Objects Panel
The Modify Objects panel gives users a robust feature set for manipulating objects. The
Properties palette can be toggled on and off with the arrow in the lower right corner.

(Modify Objects panel)

3.3.2 Modify Geometry Panel
The Modify Geometry panel contains the tools for modifying existing geometry.

(Modify Geometry panel)
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The Draw Order Cascade is now larger and contains a new tool for sending external references
to the back draw order.

(Draw Order cascade)

3.4 Annotate Tab

The Annotate tab holds the tools for creating and modifying text, dimensions, leaders, tables
and their respective styles. PostalCAD 2015 automatically creates and sets the standard USPS
styles for text, dimensions, and leaders in each new drawing, ensuring standardization. The
Style dialogue box for each panel can be opened with the arrow in the lower right corner.

(Annotate tab)

3.4.1 Text Panel

The Text panel contains commands needed for creating or modifying single or multi-line text
objects. The panel no longer needs to be expanded to use the array and sequential tools.
Expanding the panel gives access to the Spell and Find commands.

(Text panel, expanded) (*Text Layer cascade expanded)

PostalCAD 2015 Features Guide Neosys Corporation January 2016 page 18



3.4.2 Dimensions Panel

The Dimensions panel contains commands needed for creating or modifying dimension objects.
The panel has been re-organized to have the most commonly used tools available without
expanding. Expanding the panel shows diameter, radius, and an editing option to add a leader
override to an existing dimension.

(Dimensions panel, expanded) (*Dim Layer cascade expanded)

3.4.3 Leaders Tools Panel
The Leader Tools panel contains multi-leader creation and editing tools. See illustration at
bottom of page.

3.4.4 Tables Panel
The Table Tools panel contains a PostalCAD table command and other utilities for linking and
extracting tables. See illustration at bottom of page.

3.4.5 Styles Panel
All annotation styles can be set at one time in the Annotation Styles panel. Many of these styles
will be pre-populated into drawings when opening PostalCAD 2015 templates.

(Leaders panel) (Tables panel expanded) (Styles panel expanded)
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3.5 Blocks Tab

The Blocks tab holds the tools used for inserting or creating blocks.

(Blocks tab)

3.5.1 Block Tools Panel
The Block Tools panel contains all the tools for inserting, creating, and reporting blocks. The
insert block dialogue box can be opened with the arrow in the lower right corner.

(Block Tools panel)

A new insert cascade allows users to see previews of all block definitions in a drawing file.

(Block Insert cascade)
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3.5.2 Modify Blocks Panel
The Modify Blocks panel has tools to modify or manipulate block entities. The Purge dialogue
box can be opened with the arrow in the lower right corner.

(Modify Blocks panel)

3.5.3 Attributes Panel

The Attributes panel contains all the tools for creating, synchronizing and modifying attributes in
block definitions. The Block Attribute Manager dialogue box can be opened with the arrow in the
lower right corner.

(Attributes panel) (Attributes panel expanded)

3.6 Xref Tab

The Xref tab contains the toolset for creating, inserting, or modifying .DWG external references,
PDF underlays, and externally referenced Image files.

(Xref tab)
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3.6.1 Xref Tools Panel

The Xref Tools panel contains all the tools for inserting, creating, and modifying external
references. Some of these tools are available on the Shift+right-click menu when working in the
drawing window. The External References palette can be toggled on and off with the arrow in
the lower right corner.

(Xref Tools panel expanded)

3.6.2 PDF Tools Panel
The PDF Tools panel contains tools for inserting and modifying PDF underlays.

(PDF Tools panel) (PDF Tools panel expanded)

3.6.3 Image Tools Panel

The Image Tools panel contains all the tools for creating, appending, and modifying externally
referenced images into a drawing file. The attach Image dialogue box can be opened with the
arrow in the lower right corner.

(Image Tools panel)

3.7 Lean Tab

The Lean tab is new for PostalCAD 2015 and has three panels devoted to documenting Lean,
5S, and Lean signage on the workroom floor.

(Lean tab)
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3.7.1 Staging Tools Panel

The Staging Tools panel is where the PostalCAD blocks and tools for creating Lean and 5S
areas of a workroom floor are located. A companion block library folder has all the necessary
blocks for the Lean areas. Many of the tools are for laying out staging areas and getting accurate
counts from the layouts.

(Staging Tools panel)

3.7.2 Sign Tools Panel

The Sign Tools panel has a button to open the Library Manager to the Sign folder housing all
the standard signs used for organizing the workroom floor. The panel contains utilities for
creating the necessary sign insert sheets users print out.

(Sign Tools panel)

3.7.3 Modify Signs Panel
The Modify Signs panel has a set of modifying tools directed specifically for the inserted sign
blocks.

(Modify Signs panel)

3.8 Create Tab
The Create tab is where the classic PostalCAD drawing utilities and tools are stored. The
conveyor utilities have been completely revamped. The new tool prompts the user to draw a

centerline and dynamic blocks are added to the layout. Column grid utility now allows single
blocks to be inserted basing the geometry on the parametric parameters in the dialogue box.

(Create tab)
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3.8.1 Workroom Floor Entities Panel
The Workroom Floor Entities panel is where the classic PostalCAD tools for creating elements
of a workroom floor are located. The new TTS tools have been added to this panel.

(Workroom Floor Entities panel)

3.8.2 Architectural Elements Panel

The Architectural Elements panel contains all the PostalCAD tools for creating the architectural
elements of an entire processing plant building or annex. This panel has been reconfigured for
PostalCAD 2015 with a smaller choice of tools and less cascading of icons.

(Architectural Elements panel)

3.8.3 Symbols Panel
The Symbols panel contains the PostalCAD utilities for inserting and working with pre-drawn
symbols from the PostalCAD library and a utility for documenting electrical circuits.

(Symbols panel)
3.9 Spaces Tab

The Spaces tab contains all the space management and transport work analysis tools.

(Spaces tab)
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3.9.1 Create & Tag Spaces Panel
The Create & Tag Spaces panel contains all the tools for creating and tagging space
management boundaries.

(Create & Tag Spaces panel)

3.9.2 Space Management Tools Panel
The Space Management Tools panel contains the editing tools for space management. The
space management reporting tool is also on this panel.

(Space Management Tools panel)

3.9.3 Affinity Analysis Panel
The Affinity Analysis panel contains all the tools for affinity analysis among operations on a
workroom floor drawing.

(Affinity Analysis panel)

3.9.4 Transport Work Analysis Panel
The Transport Work Analysis panel contains all tools related to setting up and analyzing mail
transport through a workroom floor layout drawing.

(Transport Work Analysis panel)
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3.10 Pages Tab

The Pages tab contains the tools necessary for using Layout tabs. Paper Space setup, creation,
and editing all occur with the tools found in these panels.

(Pages tab)

3.10.1 Viewports Panel

The Viewports panel contains the tools for working in the paper space layout tabs. Viewport
creation and editing tools are found in this panel. The Viewports dialogue box can be opened
with the arrow in the lower right corner.

(Page Setup & Viewport Creation panel)

3.10.2 Titleblocks Panel
The Titleblocks panel contains utilities for placing formal labels and attributed title blocks into
layout tabs.

(Titleblocks panel)

3.10.3 Layout Tabs Panel
The Layout Tabs panel contains tools for creating, navigating, and deleting layout tabs.

(Layout tabs panel)
3.10.4 Evacuation Routes Panel
The Evacuation Routes panel contains the tools for setting up and creating fire evacuation or
assembly point routes in a layout tab. The Xref Tools panel in the Xref tab is a companion panel
used for creating externally referenced data for the final fire evacuation routes.

(Evacuation Routes panel)
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3.11 Cleanup Tab

The Cleanup tab contains a wealth of tools and utilities for Cleaning up a drawing for complying
with PostalCAD standards or correcting commonly occurring drafting format problems.

(Cleanup tab)

3.11.1 Cleanup Tools Panel

The Cleanup Tools panel contains tools not specific to text or block entities. Monster Cleanup
combines many of the tools found in all three panels of the Cleanup tab. The Purge dialogue
box can be opened with the arrow in the lower right corner.

(CLeanup Tools panel)

3.11.2 Fix Layers Panel
The Fix Layers panel contains cleanup tools for fixing most layer related issues.

(Fix Layers panel)

3.11.3 Fix Text Panel
The Fix Text panel has some quick fixing utilities for textual entities.

(Fix Text panel)
3.11.4 Fix Blocks Panel
The Fix Blocks panel contains reporting and block tools for use on one or more blocks within a
drawing file.

(Fix Blocks panel)
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3.12 Display Tab

The Display tab is where the user manipulates the look of various areas within a drawing or the
application window. Panels have been created for viewing a drawing, and the overall display of
application interface components, including palette visibility.

(Display tab)
3.12.1 Viewing Panel
The Viewing panel controls the Model tab display window. Basic zooming, panning, saving or
restoring views can all be accessed from this panel. The View Manager dialogue box can be
opened with the arrow in the lower right corner.

(Viewing panel)
3.12.2 User Interface Panel
The User Interface panel controls changes to the application window. The new Quick Viewing
tools are available in this panel. The Display tab of the Options dialogue box can be opened with
the arrow in the lower right corner.

(User Interface panel)

3.12.3 Palettes Panel
The Palettes panel is new for PostalCAD 2015 and has toggle buttons for the main palettes.

(Palettes panel)

3.13 Tools Tab

The Tools tab contains utilities ranging from simple file tools to a global fix all utility. A wealth of
help and learning materials are found in the Resources panel of this tab.

(Tools tab)
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3.13.1 Utilities Panel
The Utilities panel contains a full set of tools for various uses, including working with drawing
files as well as reading entity information.

(Utilities panel)

(Utilities panel, expanded)

3.13.2 Selection Tools Panel
The Selection Tools panel lists available filters for various types of selection sets. The Quick
Select dialogue box can be opened with the arrow in the lower right corner.

(Selection Tools panel)

3.13.3 Resources Panel

The Resources panel has the help file needed for using AutoCAD 2012 and Autodesk Map
3D 2012. Internet shortcuts to various PostalCAD.com pages are listed and technical support
information appears in the expanded area of the panel.

(Resources panel)

(Resources panel, expanded)
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4.0 PostalCAD Quick Access Layers Toolbar Overview

The PostalCAD 2015 Quick Access Toolbar is docked permanently below the Ribbon. This area
contains all of the layering tools needed for any drawing. The main tools are on the left side and
cascading areas with theme specific tools are on the right. The layering in a drawing is crucial
for organizing a drawing. Users should review the important options that are available in the
cascades because they are not visible all of the time.

NOTE: PostalCAD commands in the Quick Access Layer toolbar are preceded with an asterisk
(*) in the text label and all others are AutoCAD commands.

4.1 Left Three Buttons

The left three buttons on the Quick Access Layer toolbar are for the following utilities:
1. Toggle the Layer Properties Manager palette to be visible or not
2. Opens the Make PostalCAD Layer dialogue box
3. Starts the Quick Make Layer utility

2. Make a standardized

PostalCAD layer (MLA) \4

1. Layer Properties | ___—" +— | 3. "Quick make
palette toggle (Left three buttons) |ayer tool (QL)

4.2 Layer Control Box
The Layer Control box expands when mouse focus is applied by clicking into the initial box. The
2015 Layer Control box has been made wider to accommodate longer layer names.

(Layer Control box)

4.3 Pick Current Layer Button
The Pick Current button allows the user to set the current layer by picking an object.

\

Pick Current button

(Pick Current button)
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4.4 Filter Layers Cascade Button
The Filter Layers cascade button expands to show the filters that can be applied to the Layer
Control pulldown list.

4.5 Turn Layer(s) On or Off Cascade Button
The Turn Layer(s) On or Off cascade button expands to show all the tools for turning layers On
or Off. The bottom button will flash one or more selected layers.

4.6 Freeze or Thaw Layer(s) Cascade Button
The Freeze or Thaw Layer(s) cascade button expands to show all the tools for freezing or
thawing layers.

(Filter Layers cascade button) (Turn Layer(s) On or Off cascade button) (Freeze or Thaw Layer(s) cascade button)

4.7 Isolate Layer(s) Cascade Button
The Isolate Layer(s) cascade button expands to show all the tools for isolating layers.

4.8 Lock or Unlock Layer(s) Cascade Button
The Lock or Unlock Layer(s) cascade button expands to show all the tools for locking or
unlocking layers. The bottom button toggles on the fading of locked layers.

4.9 Save or Restore Layer States Cascade Button
The Save or Restore Layer States cascade button expands to show all the tools for working
with layer states.

(Isolate Layer(s) cascade button) (Lock or Unlock Layer(s) cascade button) (Save or Restore Layer States cascade button)
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4.10 Layer States control box
The Layer States control box expands to show all the layer states in a drawing.

(Layer States control box)

4.11 Match Properties Button
The Match Properties button is the last button on the right and is used for matching the layer
properties of another object.

(Match Properties button)

Match Properties button

PostalCAD 2015 Features Guide Neosys Corporation January 2016 page 32



5.0 New Tools in PostalCAD 2015

PostalCAD 2015 has new and improved features integrating directly into Autodesk Map 3D 2015
software. The PostalCAD tools in the Ribbon are preceded with an (*) to visually separate them
from AutoCAD items.

5.1 New Integration

PostalCAD 2012 is integrated into every drawing opened within Autodesk Map 3D 2012. The
following listing shows the changes and effects occurring upon opening a file:

— PostalCAD 2015.dwt template is the default template for all new drawings

— Standard styles for text, dimensions, and leaders are added automatically

— Units are set to “Architectural”.

— Insert units are set to “Unitless”.

— Current color and line type are set to “Bylayer”.

— UCS icon is turned Off

— All PostalCAD dialogue boxes load and respond quicker using Microsoft .net
programming.

5.2 New Tools

PostalCAD 2015 offers many new tools for enhanced ease and speed in creating and editing
any type of drawing.

5.2.1 Home Tab>Hatch panel
— *Quick PDF: Quickly create a windowed area of a drawing into an 8-1/2" x 11”
PDF. Portrait or landscape orientation is determined by orientation of window
selection.

5.2.2 Draw Tab>Hatch panel
— *Highlight: Highlight selected object(s) with solid hatch. Yellow is default color
with an option to choose another or set transparency.

5.2.3 Modify Tab> Modify Objects Panel
— *Merge Areas: Merges closed polylines into one polyline.
— *Align along X or Y: Align object(s) along X or Y axis.

5.2.4 Modify Tab> Modify Geometry Panel>Draw Order
— *XREF to Back: Send all .dwg XREFs to back of the draw order.

5.2.5 Annotate Tab>Text Panel>Align>
— *Move & Align: Move and align text to a line or polyline.
— *Copy & Align: Copy and align text to a line or polyline.

5.2.6 Annotate Tab>Dimensions Panel>*Dim Layer
— *N-ARCH-DIM: Creates and sets current the N-ARCH-DIM layer.
— *N-Equipment-DIM: Creates and sets current the N- Equipment -DIM layer.
*N-ARCH-DETAIL-DIM: Creates and sets current the N-ARCH-DETAIL-DIM
layer.
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5.2.7 Blocks Tab>Block Tools Panel
— Insert (Cascade): User can select a block from the block table with a window
showing large previews of the block needed.

(Expanded Insert button)

— *Replace: User selects block definition that will be replaced either singularly or
all occurrences at one time. Definition can be from current file or a selected
folder. Default folder is PostalCAD library.

— WBIock: Write a new file from dialogue box selection.

— *Flash Selected: User selects block(s) that will flash (5) times.

5.2.8 Xref Tab>Attributes Panel
— All attribute tools now combined in a smaller panel with extra commands in the
cascading list.
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5.2.9 Xref Tab>XREF Tools Panel

Xref palette toggle button.

*Open Xref: Opens a selected Xref for editing.

*Full to Relative: Changes a selected Xref path from Full to Relative.
*Append: Can push objects from current drawing to an Xref or pull objects from
an Xref to current drawing. Replaces PostalCAD 2012 append Xref tool.

5.2.10 LEAN Tab>Staqing Tools Panel

*Staging Library: Insert Staging Blocks using the PostalCAD Library Manager.
*Lane Arrows: Insert swim lane direction arrows onto an existing dynamic staging
block named Swim Lane Staging or Swim Lane Staging-Wide.

*Flip Arrows: Rotates existing swim lane arrows 180 degrees.

*5S Staging: Insert a dynamic 5S staging block that can be labeled and resized.
*Staging Legend: Inserts and scales by DIMSCALE factor a staging legend that has
attributes. Attributes can be updated with the *Legend Update tool.

*Legend Update: Updates an existing staging legend block with a count of all staging
blocks on any of the following standard staging layers.

e M-STAGING-DAMAGED-TRAY
M-STAGING-EMM
M-STAGING-FLAT LIDS
M-STAGING-FLAT TUBS
M-STAGING-HALF TRAYS
M-STAGING-LETTER
M-STAGING-MM
M-STAGING-PALLETS
M-STAGING-SACKS-ORANGE
M-STAGING-SACKS-WHITE
M-STAGING-SLEEVE-DISPOSAL
M-STAGING-SLEEVES
N-LEGEND-STAGING

*Container Report: Counts all dynamic staging block arrays Optional table object can
be placed in drawing based on DIMSCALE for scaling. A Notepad file will always
appear with the total count of all staging blocks.

5.2.11 LEAN Tab>SIGN Tools Panel

*SIGN Library: Insert sign blocks using the PostalCAD Library Manager.

*Swim Lanes: Inserts sign blocks onto an existing dynamic staging block named
Swim Lane Staging or Swim Lane Staging-Wide. Utility will create a separate
block for each lane encountered.

*Equipment: Inserts sign blocks onto an existing equipment block from
PostalCAD AS504 Library. Utility will create a separate block for each piece of
equipment encountered.

*Add Sign: Insert a sign block through command line options.

*Export to Excel: Exports sign block data into an Excel template.

*Insert Tab: Adds a new layout tab to match sign type selected.

*Order Tabs: Alphabetizes all layout tabs.

*Fix Layers: Checks all sign blocks for dynamic options and changes block layer
properties to match.
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— *Characters: Checks all sign blocks for character limits. The utility highlights any
blocks that exceed limit with a solid hatch pattern. Utility also creates a Word file
with an itemized list of block names with the attribute values that are in error.

— *Common: Selection tool to find all common blocks.

— *Highlight: Utility let’s user highlight any sign blocks that need to be reordered.

5.2.12 Create Tab>Workroom Floor Entities Panel

*Column Grid: New dialogue box layout including option for single column block.

— *Hatch Aisles: Create transparent hatch pattern in M-AISLE objects.

— *TTS: Robust utility for laying out and editing tray transport systems with
elevations.

— *Overhead Marker: Reset existing elevation position of incline/decline blocks.

— *Match Elevation: Matches elevation of existing blocks.

— *Polyline Direction: Shows polyline direction with options to reverse.

5.2.13 Create Tab>Architectural Elements Tools Panel
*Door & Opening: Breaks existing wall lines into doorway and adds a door
block.
*Door Only: Inserts a door block into an existing opening.
— *Door Tag: Inserts a door tag block at the arc of a door block.

5.2.14 Spaces Tab>Create & Tag Spaces Panel
— *Sequential: Command line tool for sequentially tagging existing spaces.
— *Validate: Validates selected tagged spaces for correct square footage.
— *Merge: Merges two closed polylines, whether tagged or not.
*Split: Splits a space into two separate spaces using a single line segment.

5.2.15 Spaces Tab>Transport Work Analysis Panel>WSU Tagqging
— *Import Names: Imports space names from a selected transport work
spreadsheet and displays them to the right of the extents of the workroom.
*Drag/Drop Tags: Drag and drop space tags from imported list.

5.2.16 Pages Tab>Layout Tabs Panel
— *Delete Tab: Deletes a selected tab using a dialogue box.
— *Go To Tab: Sets a selected tab current using a dialogue box.
*Model Tab: Sets the Model tab to be current.

5.2.17 Pages Tab>Evacuation Routes Panel
— *Evac Tab: Creates a new evacuation route tab numbered sequentially from the
last tab created.
— *Route Length: Inserts a text object that lists the chosen route length in decimal
feet.

5.2.18 CLeanup Tab>CLeanup Tools Panel
— *Move Origin: Moves all objects in a drawing to a new position based off of
where the 0,0,0 location should be.

5.2.19 CLeanup Tab>Fix Layers Panel
— *Add Prefix: Adds a standardized prefix letter to selected layers.
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5.2.20 CLeanup Tab>Fix Blocks Panel
*Blocks On Layer: Count the number of objects on a specified layer within a
block definition.
— *Rename: Rename a block definition by selecting an existing block or from a list
of all blocks within the drawing.

5.2.21 Display Tab>User Interface Panel

— Recent Files: Button opens the “New Tab” file tab below the Ribbon to open
recent files, start a new drawing, or open a standardized PostalCAD template to
start a new drawing.

— File Tabs: Button to toggle on and off the file tabs below the Ribbon tabs.

— Layout Tabs: Button to toggle on and off the model and paper space tabs.

— Status Bar: Button to toggle on and off the status bar icons at the bottom of the
application window.
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Appendix A — System Requirements

For a complete listing of the system requirements for AutoCAD 3D 2015 64 bit with PostalCAD
2015 see the following Autodesk website:
https://knowledge.autodesk.com/support/autocad-map-
3d/troubleshooting/caas/sfdcarticles/sfdcarticles/System-requirements-for-AutoCAD-Map-3D-
2015.html

Appendix B — PostalCAD 2015 Installation

The installation of PostalCAD 2015 is available as a bundled download with AutoCAD Map 3D
2015 64 bit from the eAccess system via the USPS intranet. Once the setup program is initiated,
the program will install itself.

Important: PostalCAD 2015 can only be installed after the compatible Autodesk Map 3D 2015
64 bit program is installed on the target system. PostalCAD is an overlay that works on top of an
existing Autodesk Map 3D 2015 64 bit installation.

The Autodesk Map 3D 2015 64 bit installation uses a Flex License system for authorizing use of
the product. When a user opens Autodesk Map 3D 2015, the Flex License Manager installed on
the local machine accesses the USPS server in Merrifield, Virginia for an authorization to use
an available, temporary license. If the local machine is not connected to the USPS intranet, the
software cannot be started. A license may be borrowed for a short period of time while a user is
connected to the intranet, if a user needs access to the software when traveling or on a workroom
floor with a laptop.

Those users who have stand alone, single seat licenses should contact the USPS PostalCAD
program representative at USPS Headquarters to upgrade to PostalCAD 2015 free of charge.

USPS PostalCAD Program Representative Contact Information:

Richard B. Sowdon, PE
Network Operations Engineering
Richard.B.Sowdon@usps.gov

475 L'Enfant Plaza SW, Room 7539
Washington, DC 20260
(202) 276-3246
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Appendix C — PostalCAD Training

Professional classroom training is available at the USPS executive training facility, William F.
Bolger Center, in Potomac Maryland.

Training descriptions, USPS course numbers, and a calendar of available classes is posted on
the PostalCAD website, http://www.postalcad.com/training.htm. For additional classroom
training information or general training questions, contact Kelly Williams at Neosys Corporation,
(540) 752-4607, or by email, Kelly@eNeosys.com.

Each series of learning builds on the previous level of training or uses references from other
courseware. The following list is a suggested sequence for learning PostalCAD from the most
basic use through the upper levels of analysis and design.

Introduction to PostalCAD

PostalCAD Plant Layout
PostalCAD Standardization
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